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1 SPICE

1.1 Εισαγωγικά και συνεχές

SPICE (Simulation Program with Integrated Circuit Emphasis) είναι ένας γενικής χρήσεως εξομοιωτής αναλογι-
κών ηλεκτρικών και ηλεκτρονικών κυκλωμάτων. Ο αρχικός κώδικας αναπτύχθηκε στο Πανεπιστήμιο Berkeley
στην Αμερική το 1973. Ήταν public domain και γρήγορα διαδόθηκε στην επιστημονική κοινότητα. Ακολούθη-
σαν διάφορες εξελίξεις που βελτίωσαν την αρχική εφαρμογή και οι εταιρίες που κατασκευάζουν και πωλούν
ολοκληρωμένα κυκλώματα έχουν προσθέσει πολλές βιβλιοθήκες με τα προϊόντα τους. Δεν νοείται σήμερα
ηλεκτρολόγος που ασχολείται με ηλεκτρικά κυκλώματα να μην χρησιμοποιεί κάποια μορφή του.

Η Microsim ήταν η πρώτη εταιρία που πήρε τον κώδικα Berkeley spice και τον έβγαλε σε προϊόν για PC το
1984. Έτρεχε σε περιβάλλον DOS και χωρούσε σε δυο δισκέτες των 360 kb. Διέθεσε επίσης και ένα Student
version με περιορισμό στον αριθμό στοιχείων που μπορούσε να χρησιμοποιήσει κανείς δωρεάν. Η τελευταία
διαθέσιμη έκδοση του Pspice student version ήταν η 9.1 το 2000. Την Microsim την αγόρασε η Orcad την
οποία αργότερα αγόρασε η Cadence. Η Cadence μέχρι πριν λίγα χρόνια διέθετε το Orcad spice σε δωρεάν
Lite εκδόσεις με περιορισμούς. Οι πλήρεις εκδόσεις με πλούσιες βιβλιοθήκες στοιχείων και τη δυνατότητα
σχεδιασμού σε επίπεδο PCB είχαν το ανάλογο κόστος. Σήμερα, δωρεάν χρήση υπάρχει μόνο με συμμετοχή στο
Academic Program της εταιρίας με συνεργαζόμενα Πανεπιστήμια.

Ένας από τους διαδόχους ανοιχτού λογισμικού της τελευταίας έκδοσης του SPICE 3F5 είναι το ngspice (από
το 1993) με ομάδα που ακόμα το επικαιροποιεί και το αναπτύσσει.

Ένα απλό ψάξιμο στο internet γρήγορα θα οδηγήσει στο πρόγραμμα LTspice της εταιρίας Linear Technology σαν
ίσως την πιο δημοφιλή δωρεάν έκδοση του SPICE. Πολύ καλά σχόλια από πλήθος σχεδιαστών κυκλωμάτων από
όλο τον κόσμο. Η πρώτη έκδοση βγήκε το 1999 και η εταιρία σκόπιμα δεν έβαλε περιορισμούς στο προϊόν της. Το
LTspice είχε ενσωματωμένες βιβλιοθήκες με όλα τα προϊόντα της εταιρίας. Οι συχνές αναβαθμίσεις που έκανε και
η διάθεση μεγάλου πλήθους σχεδιασμών το έκαναν πολύ εύχρηστο. Το 2017 η Linear Technology ενσωματώθηκε
με την Analog Devices, μια από τις μεγαλύτερες εταιρίες ολοκληρωμένων και το 2021 με την Maxim Integrated.
Το LTspice συνεχίζει να είναι διαθέσιμο δωρεάν και οι βιβλιοθήκες στοιχείων συνεχώς εμπλουτίζονται.

Το TINA-TI είναι άλλη μια δωρεάν εφαρμογή spice που είδα να προτείνεται με καλά σχόλια πριν λίγα χρόνια,
μαζί με το LTspice, στο online course 6002x, Circuits and Electronics του MIT (edx.org). Την κατεβάζετε από
το tina-ti (πρώτη επιλογή στα αγγλικά) και κάνετε εγκατάσταση με τον συνήθη τρόπο. Θα σας ζητηθεί να
συμπληρώσετε μια φόρμα με τα στοιχεία σας για να ολοκληρώσετε την εγκατάσταση. Από ότι φαίνεται η Texas
Instruments έχοντας το παράδειγμα της Linear Technology προς μίμηση, συνεννοήθηκε με την DesignSoft που
έχει μια πολύ καλή εμπορική εφαρμογή spice, την TINA, και έκαναν μια ανεξάρτητη εφαρμογή, την TINA-TI,
που ενσωματώνει βιβλιοθήκες με τα προϊόντα της Texas Instruments. Διατίθεται δωρεάν και είναι και αυτή μια
καλή επιλογή για σχεδιαστές κυκλωμάτων. Υπάρχει video tutorial για την TINA-TI στο τέλος της σελίδας που
κατεβάζετε την εφαρμογή. Υπάρχει επίσης free internet course on circuit theory από την DesignSoft που
μπορεί να σας φανεί χρήσιμο.

Στα παρακάτω θα δοκιμάσουμε το LTspice και TINA-TI σε ένα απλό κύκλωμα συνεχούς, Σχ. 1.

−
+36 V

5.7 Ω 3.1 Ω

2 Ω 4.5 A 0.4 Ω

𝐴 𝐵

Σχήμα 1: Κύκλωμα παράδειγμα συνεχούς

Χρησιμοποιώντας κομβική ανάλυση βλέπουμε ότι έχουμε δυο κόμβους, Α και Β. Εφαρμογή του κανόνα ρευμάτων
Kirchhoff για τους δυο κόμβους όπου εκφράζουμε τα ρεύματα που εισέρχονται ή εξέρχονται από τους κόμβους
συναρτήσει των τάσεων 𝑉𝐴, 𝑉𝐵 μας δίνει:

𝑉𝐴 − 36
5.7 + 𝑉𝐴

2 + 𝑉𝐴 − 𝑉𝐵
3.1 = 0

𝑉𝐵 − 𝑉𝐴
3.1 − 4.5 + 𝑉𝐵

0.4 = 0

⎫}}
⎬}}⎭

⇒
𝑉𝐴( 1

5.7 + 1
2 + 1

3.1) − 𝑉𝐵( 1
3.1) = 36

5.7

−𝑉𝐴( 1
3.1) + 𝑉𝐵( 1

3.1 + 1
0.4) = 4.5

⎫}}
⎬}}⎭

⇒ 𝑉𝐴 = 7.1061 V
𝑉𝐵 = 2.4064 V
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1.1.1 LTspice

Το αρχικό παράθυρο φαίνεται στο Σχ. 2.

Σχήμα 2: Ο καμβάς του LTspice πριν τη δημιουργία σχηματικών.

Το δεύτερο εικονίδιο με το + ξεκινά τη δημιουργία καινούργιου σχηματικού και ενεργοποιούνται τότε και τα
άλλα εικονίδια. Στο Σχ. 3 βλέπουμε μερικά από αυτά (μετακινώντας το mouse πάνω από κάθε εικονίδιο μας
εμφανίζει πληροφορία του τι είναι το καθένα). Κάνοντας κλικ στη δημιουργία νέου σχηματικού, δημιουργεί-
ται ένα καινούργιο κενό σχηματικό. Μπορούμε τότε να τοποθετήσουμε όσα στοιχεία θέλουμε στο σχηματικό.
Αντιστάσεις απο το εικονίδιο αντιστάσεων, πηγές τάσης (voltage) απο το εικονίδιο πηγών τάσης και πηγές
ρεύματος (current) από το εικονίδιο όλων των στοιχείων (ψάχνοντας και κάνοντας κλικ στα αγγλικά τους ονό-
ματα). Κλικ στο δεξί κουμπί του ποντικιού σταματά την επιλογή ενός συγκεκριμένου στοιχείου. Όσα στοιχεία
έχουμε εισάγει μένουν στις θέσεις που τα έχουμε τοποθετήσει. Χρησιμοποιώντας τα εικονίδια βελάκια προς τα
δεξιά του toolbar μπορούμε να τα μετακινήσουμε στις θέσεις που θέλουμε στον καμβά, να τα περιστρέψουμε
καθώς και να κάνουμε αντίγραφα.

Σχήμα 3: Τα βασικά εικονίδια όταν δουλεύουμε με σχηματικά.

Μπορούμε ταυτόχρονα, όταν είναι ενεργοποιημένο το εικονίδιο move να περιστρέψουμε το στοιχείο κατά 90∘

με το Ctrl-R. Με το ροδάκι του ποντικιού μπορούμε να μεγεθύνουμε ή να σμικρύνουμε το σχηματικό. Όταν
έχουμε όλα τα στοιχεία που θέλουμε με τον προσανατολισμό που θέλουμε μπορούμε να τα ενώσουμε με τις
ηλεκτρικές γραμμές της εφαρμογής. Μην ξεχάσετε να τοποθετήσετε και τη «γείωση», το σημείο αναφοράς για
τις τάσεις σε όλο το κύκλωμα. Μετακινώντας το ποντίκι πάνω από κάθε στοιχείο μέχρις ότου εμφανιστεί ένα
μήνυμα για edit, κάνοντας κλικ στο δεξιό κουμπί του ποντικιού, μπορούμε να εισάγουμε την αριθμητική τιμή
του στοιχείου (Σχ. 5). Όταν έχουμε δώσει τιμές σε όλα τα στοιχεία μπορούμε να κάνουμε κλικ στο κίτρινο βελάκι
και να τρέξουμε το πρόγραμμα. Την πρώτη φορά θα ανοίξει μια φόρμα (Σχ. 7(a)) που θα μας ρωτά τι είδους
ανάλυση θέλουμε. Επιλέγουμε DC op pnt (DC operating point), το σημείο λειτουργίας του κυκλώματος υπό
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συνθήκες συνεχούς ρεύματος, και όταν κάνουμε κλικ OK θα μας κάνει την ανάλυση. Όλα τα αποτελέσματα
την ανάλυσης φαίνονται στο Σχ. 7(b) και ταυτίζονται με τους υπολογισμούς μας.

Σχήμα 4: Επιλογή πηγής ρεύματος.

Σχήμα 5: Εισαγωγή τιμών για τα στοιχεία αντίστασης και τάσης.

Σχήμα 6: Το έτοιμο σχηματικό.
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Σχήμα 7: (a) Επιλογή τύπου ανάλυσης. Για συνεχές ρεύμα η μόνη επιλογή είναι το DC op pnt (DC operating
point). (b) Όλα τα αποτελέσματα της ανάλυσης.

1.1.2 TINA-TI

Στο TINA-TI, η πρώτη εικόνα στην οθόνη μας όταν πρωτοτρέχουμε την εφαρμογή φαίνεται στο Σχ. 8. Δίνεται η
επιλογή να χρησιμοποιηθούν US (ANSI) σύμβολα ή European (DIN). Στο παρακάτω παράδειγμα έχουν επιλεγεί
τα ANSI.

Σχήμα 8: Η εικόνα όταν πρωτοτρέχουμε την εφαρμογή TINA-TI

Ανοίγει αμέσως το σχηματικό παράθυρο με τα πιο κοινά στοιχεία άμεσα διαθέσιμα. Επιλέγουμε και τοποθετούμε
τα στοιχεία που θέλουμε στο σχηματικό, είτε οριζόντια είτε κάθετα (με Ctrl-R). Διπλό κλικ στις τιμές των
στοιχείων ανοίγει μια φόρμα διαλόγου όπου επιλέγουμε τις δικές μας τιμές.

Υπάρχει επίσης και ένα «παχύ» μολύβι για να ζωγραφιστούν τα σύρματα/αγωγοί που ενώνουν τα στοιχεία. Το
έτοιμο σχηματικό φαίνεται στο Σχ. 10. Κάνοντας κλικ στην ανάλυση για το bias point μας δίνεται η δυνατότητα
να χρησιμοποιήσουμε ένα εικονικό probe, σαν πολύμετρο, για να βλέπουμε την τάση σε όποιο κόμβο θέλουμε
(βλ. Σχ. 11). Δίνεται επίσης η επιλογή για όλα τα αποτελέσματα της ανάλυσης (βλ. Σχ. 12).

Και εδώ, τα αποτελέσματα συμπίπτουν με τους υπολογισμούς μας. Ένα ίσως καλό σε σύγκριση με το LTspice
είναι ότι αναγράφονται στο σχηματικό οι κόμβοι, άρα φαίνεται απευθείας η πολικότητα τάσεων και ρευμάτων.
Στο LTspice πρέπει να δούμε το netlist, View -> SPICE Netlist.

1.1.3 Netlists και εξαρτημένες πηγές

Το SPICE είναι χρήσιμο γιατί μπορεί να επιβεβαιώνει τις λύσεις που καταλήγουμε όταν αναλύουμε κάποιο
ηλεκτρικό κύκλωμα με μία από τις κλασσικές αναλυτικές μεθόδους (π.χ. κανόνες Kirchhoff). Με τον τρόπο
αυτό ξεκαθαρίζονται γρήγορα οι έννοιες που δεν έχουν αφομοιωθεί σωστά και αυξάνεται η ικανότητα επίλυσης
ηλεκτρικών κυκλωμάτων. Το SPICE χρειάζεται ένα netlist σαν input, δηλ. ένα αρχείο όπου περιγράφεται το
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Σχήμα 9: Φόρμα διαλόγου όπου επιλέγουμε τις τιμές των στοιχείων.

Σχήμα 10: Το σχηματικό έτοιμο.

Σχήμα 11: Μετά την ανάλυση μας δίνει την δυνατότητα να χρησιμοποιήσουμε ένα εικονικό probe για τάση σε
όποιο σημείο θέλουμε.

Σχήμα 12: Ή, όλα τα αποτελέσματα της ανάλυσης.
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κύκλωμα που έχουμε προς ανάλυση, από τους κόμβους και τα ηλεκτρικά του στοιχεία. Στο τέλος π.χ. της
απλής ανάλυσης DC το πρόγραμμα δίνει τις τάσεις σε όλους τους κόμβους σε σχέση με τον κόμβο αναφοράς
καθώς επίσης και τα ρεύματα που διέρχονται μέσα από κάθε πηγή τάσης.

To SPICE από μόνο του είναι ένα command line program, δηλ., πρέπει πρώτα να περιγράψει κανείς το κύκλωμα
με ένα αρχείο netlist, χρησιμοποιώντας έναν απλό ASCII editor, π.χ. Notepad (λειτουργικό Windows), να το
δώσει σαν input στο SPICE και να πάρει τα αποτελέσματα της ανάλυσης τα οποία μπορεί να είναι σε μορφή
text, κάποιου αρχείου ή γραφικών παραστάσεων.

Για απλά κυκλώματα με λίγα στοιχεία δεν έχει ιδιαίτερη σημασία αν φτιάξει κανείς το δικό του netlist ή
χρησιμοποιήσει κάποιο σχηματικό πρόγραμμα. Η σημασία έρχεται αργότερα όταν μεγαλώσει το κύκλωμα και ο
αριθμός στοιχείων. Φαίνεται τότε ότι το σχηματικό είναι πιο εύχρηστο γιατί είναι πιο κατανοητό και εντοπίζονται
πιο εύκολα οτιδήποτε προβλήματα. Χρειάζεται όμως και γνώση netlist γιατί μέσα από αυτά φαίνεται η σύνδεση
των στοιχείων του κυκλώματος στους κόμβους του και είναι ξεκάθαρο το ποιος ακροδέκτης είναι θετικός και
ποιος αρνητικός. Αυτό είναι ιδιαίτερα χρήσιμο σε κυκλώματα εναλλασσομένου όπου μπορεί να βγει κάποια
λύση με διαφορά φάσης 180∘ από την πραγματική λόγω του ότι το στοιχείο έχει τοποθετηθεί ανάποδα.

Ένα αρχείο netlist περιέχει τα ακόλουθα:

• Τίτλος και εντολές σχολίων
• Εντολές data
• Εντολές ελέγχου (control statements)
• Εντολές εξόδου (output statements), και
• την εντολή τερματισμού end

Τίτλος και εντολές σχολίων

Ο τίτλος (title statement) είναι η πρώτη γραμμή του αρχείου και τυπικά περιγράφει συνοπτικά το κύκλωμα
που ακολουθεί. Τα σχόλια (comment statements) διακρίνονται από τον αστερίσκο στην πρώτη στήλη και δίνουν
επεξηγηματικές πληροφορίες/σχόλια για το τμήμα που ακολουθεί. Το SPICE τις αγνοεί.

Εντολές data

Το κύκλωμα περιγράφεται από τους κόμβους του και τα στοιχεία που υπάρχουν μεταξύ των κόμβων. Διακρίνεται
ο κόμβος αναφοράς 0 και η αρίθμηση των υπολοίπων (αυθαίρετη) δείχνει πως συνδυάζονται οι διάφοροι κλάδοι
του κυκλώματος. Τα διάφορα πεδία μιας εντολής data ξεχωρίζουν από ένα ή περισσότερα κενά, μία ισότητα,
ή από το άνοιγμα ή κλείσιμο μιας παρένθεσης. Μία εντολή μπορεί να συνεχιστεί στην επόμενη γραμμή αν η
πρώτη στήλη της επόμενης γραμμής περιέχει το +. Το πρόγραμμα συνεχίζει τότε την προηγούμενη εντολή από
την στήλη 2.

Η θεμελιώδης μονάδα μιας εντολής data είναι ο κλάδος, το τμήμα του κυκλώματος μεταξύ δύο συνεχών κόμβων.
Πρέπει οπωσδήποτε να υπάρχει ένα στοιχείο σε κάθε κλάδο. Αν δεν υπάρχει, σημαίνει ότι οι δύο κόμβοι είναι
στην πραγματικότητα ένας. Αν υπάρχουν παραπάνω από ένα στοιχεία, τότε έχουμε παραπάνω από έναν
κλάδους. Και στις δύο περιπτώσεις το πρόγμαμμα θα μας βγάλει error και δεν θα τρέξει.

Οι δύο κόμβοι στα άκρα του κλάδου χρησιμοποιούνται να περιγράψουν την τάση στα άκρα του στοιχείου που
περιέχει ο κλάδος. Τα στοιχεία μπορεί να είναι αντιστάσεις, πηγές τάσεως, πηγές ρεύματος, πηνία, πυκνωτές,
δίοδοι, τρανζίστορ, κλπ. Εμείς εδώ συγκεντρώνουμε την προσοχή μας κυρίως στα πρώτα είδη στοιχείων. Οι
πηγές τάσεως ή ρεύματος μπορεί να έχουν μηδενική τάση ή ρεύμα, η αντίσταση όμως πρέπει να είναι μη
μηδενική.

Το πρώτο γράμμα στο όνομα του στοιχείου δηλώνει τον τύπο του στοιχείου. Έχουμε:

R Ωμική αντίσταση E Πηγή τάσης που εξαρτάται από τάση
V Ανεξάρτητη πηγή τάσης F Πηγή ρεύματος που εξαρτάται από ρεύμα
I Ανεξάρτητη πηγή ρεύματος G Πηγή ρεύματος που εξαρτάται από τάση
L Επαγωγή πηνίου H Πηγή τάσης που εξαρτάται από ρεύμα
C Χωρητικότητα πυκνωτή

Ακολουθούν μέχρι 7 αλφαριθμητικοί χαρακτήρες.

Η αριθμητική τιμή του στοιχείου μπορεί να είναι ακέραιος, π.χ. 12, −44, floating point, π.χ. 3.142, 1.4146,
ακέραιος ή floating point που ακολουθείται από εκθέτη, π.χ. 1E − 14, 2.65e3, ή ακέραιος ή floating point που
ακολουθείται από κάποιο από τα σύμβολα του Πίν. 1.
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Πίνακας 1: Προθέματα αριθμητικών τιμών στο SPICE. Προσοχή στο F. Μην το μπερδέψετε με τη μονάδα Farad
για πυκνωτές.

όνομα σύμβολο αριθμητική τιμή

tera t, ή T 1012

giga g, ή G 109

mega meg, ή MEG 106

kilo k, ή K 103

milli m, ή M 10−3

micro u, ή U 10−6

nano n, ή N 10−9

pico p, ή P 10−12

femto f, ή F 10−15

Τα γράμματα όπως βλέπουμε μπορεί να είναι κεφαλαία ή μικρά. Γράμματα που ακολουθούν μία αριθμητική
τιμή διαφορετική από τα παραπάνω σύμβολα αγνοούνται. Έτσι οι τιμές 10, 10V, 10VOLTS, 10HZ, 10hz αντι-
προσωπεύουν την ίδια αριθμητική τιμή. Ομοίως 1000, 1000.0, 1000HZ, 1E3, 1K, 1KHZ. Προσοχή εδώ στο F όταν
εννοείτε τη μονάδα Farad για πυκνωτές. Το spice καταλαβαίνει το F σαν το πρόθεμα femto, 10−15.

Για τα στοιχεία έχουμε πιο αναλυτικά:

Εντολή κλάδου για παθητικά στοιχεία

«όνομα» «κόμβοι» «αριθμητική τιμή» («αρχικές συνθήκες»)

Οι αρχικές συνθήκες είναι προαιρετικές και συνήθως έχουν νόημα για πηνία και πυκνωτές στο εναλλασσόμενο.
Οι κόμβοι είναι δύο. Για τις ηλεκτρικές αντιστάσεις δεν παίζει ρόλο πια θα βάλουμε πρώτη και πια δεύτερη.
Για τα πηνία και τους πυκνωτές ο πρώτος κόμβος είναι πάντα ο κόμβος υψηλότερου δυναμικού και ο δεύτερος
ο κόμβος χαμηλότερου δυναμικού. Για αντιστάσεις, η αριθμητική τιμή (αν δεν υπάρχει πρόθεμα) είναι σε Ω. Για
πηνία και πυκνωτές, σε H και F. Για πηγές τάσης σε V και για πηγές ρεύματος σε Α.

Παράδειγμα 1.1. Να γραφούν οι εντολές data για τα παθητικά στοιχεία του σχήματος 13.

1 𝑅𝑖𝑛 = 3k� 2

4 𝐿1 = 30�H

𝐼(0) = 2mA

5

0
𝐶𝑒𝑞 = 5pF

𝑉 (0) = −2V
6

Σχήμα 13: Παθητικά στοιχεία: ωμικές αντιστάσεις, πηνία, πυκνωτές.

Rin 1 2 3k
Rin 2 1 3k
L1 4 5 30uH IC = 2mA
Ceq 6 0 5pF IC = −2V

Εντολή κλάδου για ανεξάρτητη πηγή τάσης ή ρεύματος

«όνομα» «κόμβοι» «είδος πηγής» «αριθμητική τιμή»
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Το είδος πηγής αναφέρεται σε πηγή Σ.Ρ. (dc) ή πηγή Ε.Ρ. (ac). Οι πηγές τάσης αρχίζουν από το γράμμα V
και οι πηγές ρεύματος από το γράμμα I. Για τις πηγές τάσης ο πρώτος κόμβος είναι ο κόμβος με το θετικό
ακροδέκτη. Στον υπολογισμό ρεύματος κλάδου σε κλάδο όπου υπάρχει πηγή τάσης η φορά του ρεύματος
που υπολογίζεται είναι από τον θετικό ακροδέκτη της πηγής τάσης στον αρνητικό. Για τις πηγές ρεύματος,
το ρεύμα κυκλοφορεί από τον πρώτο κόμβο στο δεύτερο. Δηλ. ο πρώτος κόμβος είναι ο κόμβος υψηλότερου
δυναμικού και ο δεύτερος κόμβος είναι ο κόμβος χαμηλότερου δυναμικού. Δηλ. η φορά του ρεύματος ακολουθεί
τη φορά του βέλους που φαίνεται στο σύμβολο της πηγής ρεύματος.

Παράδειγμα 1.2. Να γραφούν οι εντολές data για τις πηγές του σχήματος 14.

1 − +

𝑉𝑠 = 30V
2

3
𝐼𝑏𝑖𝑎𝑠 = 2A

4

Σχήμα 14: Ανεξάρτητες πηγές συνεχούς τάσης, ρεύματος.

Vs 2 1 dc 30V
Ibias 3 4 dc 2A

Εντολές ελέγχου (control statements)

Όλες οι εντολές ελέγχου έχουν μπροστά τους μια τελεία. Αναφέρεται η εντολή .op η οποία έχει σαν αποτέλεσμα
τον υπολογισμό όλων των τάσεων στους κόμβους του κυκλώματος καθώς επίσης και των ρευμάτων που
διέρχονται από τις πηγές τάσεως σε κατάσταση Σ.Ρ.

Eντολή τερματισμού end

Η εντολή .end είναι η τελευταία εντολή του αρχείου (υποχρεωτική) και ειδοποιεί το πρόγραμμα ότι τελείωσε η
περιγραφή του κυκλώματος προς ανάλυση.

Παράδειγμα ανάλυσης με ngspice

Το ngspice είναι και αυτό εφαρμογή εξομοίωσης κυκλωμάτων σαν το LTspice και το TINA-TI, Είναι όμως πιο
κοντά στο αρχικό spice και άρα λειτουργεί με command lines ή files (netlists).

Μπορούμε να φτιάξουμε το netlist του Σχ. 1. Υπενθυμίζεται ότι στο SPICE κάθε στοιχείο βρίσκεται μεταξύ δυο
κόμβων. Η γείωση είναι ο κόμβος 0. Αντιστοιχίζουμε αυθαίρετα το Α στον κόμβο 1, το Β στον κόμβο 2 και το
+ της πηγής τάσης στον κόμβο 3. Άρα, φτιάχνουμε το αρχείο netlist, π.χ. netx.net με περιεχόμενο:

* netlist example
V 3 0 dc 36
I 0 2 dc 4.5
R1 3 1 5.7
R2 1 0 2
R3 1 2 3.1
R4 2 0 0.4
.op
.end

Το τρέχουμε (σε περιβάλλον Linux) με την εντολή

ngspice < netx.net > netx.out

και το αποτέλεσμα στο αρχείο netx.out είναι:

Note: No compatibility mode selected!
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Circuit: ,* netlist example

Doing analysis at TEMP = 27.000000 and TNOM = 27.000000

Using SPARSE 1.3 as Direct Linear Solver

No. of Data Rows : 1
Node Voltage
---- -------
---- -------
V(1) 7.106128e+00
V(2) 2.406415e+00
V(3) 3.600000e+01

Source Current
------ -------

v#branch -5.06910e+00

Resistor models (Simple linear resistor)
model R

rsh 0
narrow 0
short 0

tc1 0
tc2 0
tce 0
defw 1e-05

l 1e-05
kf 0
af 0
r 0

bv_max 1e+99
lf 1
wf 1
ef 1

Isource: Independent current source
device i

dc 4.5
m 1

acmag 0
pulse -
sin -
exp -
pwl -
sffm -

am -
trnoise -
trrandom -

v 2.40641
p -10.8289

current 4.5

Resistor: Simple linear resistor
device r4 r3 r2
model R R R

resistance 0.4 3.1 2
ac 0.4 3.1 2

dtemp 0 0 0
bv_max 1e+99 1e+99 1e+99
noisy 1 1 1

i 6.01604 1.51604 3.55306
p 14.4771 7.12494 25.2485

Resistor: Simple linear resistor
device r1
model R

resistance 5.7
ac 5.7

dtemp 0
bv_max 1e+99
noisy 1

i 5.0691
p 146.466

Vsource: Independent voltage source
device v
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dc 36
acmag 0
pulse -
sin -
exp -
pwl -
sffm -

am -
trnoise -
trrandom -
portnum 0

z0 0
pwr 0
freq 0

phase 0
i -5.0691
p -182.488

Total analysis time (seconds) = 5.2004E-05

Total elapsed time (seconds) = 0.001

Total DRAM available = 15815.605 MB.
DRAM currently available = 11611.949 MB.
Maximum ngspice program size = 18.398 MB.
Current ngspice program size = 10.609 MB.

Shared ngspice pages = 8.941 MB.
Text (code) pages = 6.441 MB.
Stack = 0 bytes.
Library pages = 1.797 MB.

Διακρίνουμε τις τάσεις V(1), V(2) που ταυτίζονται με τη λύση μας και αν κοιτάξουμε στις αντιστάσεις
r1,r2,r3,r4 βλέπουμε το ρεύμα που τις διαρρέει καθώς και την ισχύ που καταναλώνουν.

Επισημαίνεται ότι το παραπάνω netlist, netx.net, μπορούμε να το ανοίξουμε και να το τρέξουμε και με το
LTspice.

Πηγή τάσης που εξαρτάται από τάση

Η πηγή τάσης που εξαρτάται από τάση φαίνεται στο Σχ. 15. Το όνομά της ξεκινά από το σύμβολο E. Στην
περιγραφή κατά netlist χρειάζονται οι δυο κόμβοι στα άκρα της (με πρώτον αυτόν που βρίσκεται στο θετικό
ακροδέκτη), οι δυο κόμβοι ελέγχου (με πρώτον αυτόν που βρίσκεται στο θετικό κόμβο) και ο πολλαπλασιαστής
(στην περίπτωση αυτή είναι καθαρός αριθμός), που δείχνει τι πολλαπλάσιο της τάσης ελέγχου εμφανίζεται
στην πηγή. Π.χ.

E1 4 3 2 1 k1

3 − +
𝑘1𝑉21

4

5
𝑘2𝑉21

6 −
𝑉21

+
2

1

Σχήμα 15: Εξαρτημένες πηγές τάσης E και ρεύματος G από τάση.

Στο Σχ. 16 βλέπουμε πως περιγράφεται η εξαρτημένη πηγή τάσης από τάση με σχηματικό διάγραμμα στο
LTspice.

Πηγή ρεύματος που εξαρτάται από τάση

Η πηγή ρεύματος που εξαρτάται από τάση φαίνεται και αυτή στο Σχ. 15. Το όνομά της ξεκινά από το σύμβολο G.
Στην περιγραφή κατά netlist χρειάζονται οι δυο κόμβοι στα άκρα της (με πρώτον αυτόν από τον οποίο ξεκινά το
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Σχήμα 16: Παράδειγμα κυκλώματος πηγής τάσης που εξαρτάται από τάση. Βλέπουμε πως ενώνουμε τους ακρο-
δέκτες ελέγχου με την τάση στα σημεία ελέγχου. Βλέπουμε επίσης πως δίνουμε την τιμή του πολλαπλασιαστή
για την πηγή E1 (στην περίπτωση αυτή η τιμή είναι 10.)

ρεύμα), οι δυο κόμβοι ελέγχου (με πρώτον αυτόν που βρίσκεται στο θετικό κόμβο) και ο πολλαπλασιαστής (στην
περίπτωση αυτή έχει διαστάσεις αγωγιμότητας), που δείχνει τι πολλαπλάσιο της τάσης ελέγχου εμφανίζεται
στην πηγή. Π.χ.

G1 5 6 2 1 k2

Στο Σχ. 17 βλέπουμε πως περιγράφεται η εξαρτημένη πηγή ρεύματος από τάση με σχηματικό διάγραμμα στο
LTspice.

Σχήμα 17: Παράδειγμα κυκλώματος πηγής ρεύματος που εξαρτάται από τάση. Βλέπουμε πως ενώνουμε τους
ακροδέκτες ελέγχου με την τάση στα σημεία ελέγχου. Μπορούμε να διασταυρώσουμε ηλεκτρικές γραμμές και
αν δεν υπάρχει εμφανές σημείο κόμβου αυτές δεν ευρίσκονται σε επαφή. Βλέπουμε επίσης πως δίνουμε την
τιμή του πολλαπλασιαστή για την πηγή G1 (στην περίπτωση αυτή η τιμή είναι 2.)

Πηγή τάσης που εξαρτάται από ρεύμα

Η πηγή τάσης που εξαρτάται από ρεύμα φαίνεται στο Σχ. 18. Το όνομά της ξεκινά από το σύμβολο H. Στην
περιγραφή κατά netlist χρειάζεται πρώτα να προσδιοριστεί το ρεύμα ελέγχου. Ρεύμα που διαρρέει κάποιο
κλάδο στο spice προσδιορίζεται από μια πηγή τάσης (φορά ρεύματος αυτή μου μπαίνει στον θετικό ακροδέκτη
της πηγής τάσης). Αν υπάρχει μια πηγή τάσης στον κλάδο που διαρρέεται από το ρεύμα ελέγχου μπορούμε να
χρησιμοποιήσουμε αυτή. Αλλιώς έστω ότι υπάρχει μια αντίσταση μεταξύ των κόμβων 1 και 2. Εισάγουμε έναν
νέο κόμβο τον 7 και μια πηγή 𝑉𝑑𝑚𝑦 μηδενικής τάσης. Ο θετικός ακροδέκτης της πηγής είναι στον κόμβο 1 και
ο αρνητικός στον κόμβο 7 γιατί το ρεύμα ελέγχου έχει φορά από τον κόμβο 1 στον 2. Επομένως
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Vdmy 1 7 dc 0
H1 4 3 Vdmy k3

Ο πολλαπλασιαστής k3 έχει διαστάσεις αντίστασης αυτή τη φορά. Στο Σχ. 19 βλέπουμε πως περιγράφεται
αυτό το στοιχείο με σχηματικό διάγραμμα LTspice.

3 − +
𝑘3𝐼

4

5
𝑘4𝐼

6
−
+ 𝑉𝑑𝑚𝑦 = 0

7
𝐼

2

1

Σχήμα 18: Εξαρτημένες πηγές τάσης H και ρεύματος F από ρεύμα.

Σχήμα 19: Παράδειγμα κυκλώματος πηγής τάσης που εξαρτάται από το ρεύμα που διέρχεται από την R4
από αριστερά στα δεξιά. Βλέπουμε πως έχουμε τοποθετήσει μια πηγή τάσης με μηδενική τιμή έτσι ώστε να
δηλώσουμε το ρεύμα. Βλέπουμε επίσης πως δίνουμε την τιμή του πολλαπλασιαστή για την πηγή H1 (στην
περίπτωση αυτή η τιμή είναι 2.)

Σχήμα 20: Παράδειγμα κυκλώματος πηγής ρεύματος που εξαρτάται από το ρεύμα που διέρχεται από την
πηγή τάσης V1 από πάνω προς τα κάτω. Εδώ ήδη υπάρχει πηγή τάσης έτσι ώστε να δηλωθεί το ρεύμα
και δεν χρειάζεται να εισάγουμε καινούργια με μηδενική τιμή. Βλέπουμε επίσης πως δίνουμε την τιμή του
πολλαπλασιαστή για την πηγή F1 (στην περίπτωση αυτή η τιμή είναι 2.)

Πηγή ρεύματος που εξαρτάται από ρεύμα

Η πηγή ρεύματος που εξαρτάται από ρεύμα φαίνεται και αυτή στο Σχ. 18. Το όνομά της ξεκινά από το σύμβολο
F. Στην περιγραφή κατά netlist χρειάζεται πρώτα να προσδιοριστεί το ρεύμα ελέγχου. Ρεύμα που διαρρέει
κάποιο κλάδο στο spice προσδιορίζεται από μια πηγή τάσης (φορά ρεύματος αυτή μου μπαίνει στον θετικό
ακροδέκτη της πηγής τάσης). Αν υπάρχει μια πηγή τάσης στον κλάδο που διαρρέεται από το ρεύμα ελέγχου
μπορούμε να χρησιμοποιήσουμε αυτή. Αλλοιώς εισάγουμε μια κενή πηγή τάσης με τιμή τάσης μηδέν. Επομένως
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Vdmy 1 7 dc 0
F1 5 6 Vdmy k4

Ο πολλαπλασιαστής k4 είναι καθαρός αριθμός σε αυτή την περίπτωση. Στο Σχ. 20 βλέπουμε πως περιγράφεται
αυτό το στοιχείο με σχηματικό διάγραμμα LTspice.

Εξαρτημένες πηγές με TINA-TI

Στα Σχ. 21, 22 βλέπουμε τα αντίστοιχα παραδείγματα κυκλωμάτων που αναλύθηκαν με LTspice να αναλύονται
με TINA-TI. Το TINA-TI ξεφεύγει λίγο από τα σύμβολα του κλασσικού spice, E,G,H και F και χρησιμοποιεί
τα VCVS (Voltage Controlled Voltage Source), CCVS (Current Controlled Voltage Source), VCCS (Voltage
Controlled Current Source) και CCCS (Current Controlled Current Source). Όλα αυτά διαθέσιμα από το Sources
-> Controlled Sources.

Σχήμα 21: Οι εξαρτημένες πηγές E και G με TINA-TI.

Οι πηγές που εξαρτώνται από τάση δεν έχουν πρόβλημα υλοποίησης. Αυτές όμως που εξαρτώνται από ρεύμα
δεν δέχονται πηγή μηδενικής τάσης όπως δουλεύει στο κλασικό spice και LTspice. Δέχονται όμως πολύ μικρή
ωμική αντίσταση (δοκίμασα 1 fΩ).

Για εξάσκηση σας προτρέπω να σχεδιάσετε και να αναλύσετε τα 4 κυκλώματα εξαρτημένων πηγών με το χέρι
και να επιβεβαιώσετε τους υπολογισμούς σας με LTspice και TINA-TI.
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Τα παραπάνω μας επιτρέπουν να φτιάξουμε τα σχηματικά ή netlist και να αναλύσουμε στο spice οποιοδήποτε
κύκλωμα συνεχούς.

Σχήμα 22: Οι εξαρτημένες πηγές H και F με TINA-TI.

1.2 Κύκλωμα εναλλασσομένου

Το κύκλωμα εναλλασσομένου του Σχ. 23 λειτουργεί σε συχνότητα 𝑓 = 300 Hz και θέλουμε τα ρεύματα κλάδων
̇𝐼1 και ̇𝐼2.

−
+

150/25∘ V

̇𝐼1

220 Ω 30 mH

160 Ω

5 µF

̇𝐼2

1.5/−42∘ A

100 Ω

Σχήμα 23: Κύκλωμα εναλλασσομένου

Θέτοντας τον επάνω κόμβο σαν Α και τον κάτω σαν αναφορά, έχουμε με κομβική ανάλυση:
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̇𝑉𝐴 − ̇𝑉
𝑅1 + 𝑅2 + 𝑍𝐿

+
̇𝑉𝐴

𝑅3 + 𝑍𝐶
− ̇𝐼 = 0 ⇒ ̇𝑉𝐴 =

̇𝐼 +
̇𝑉

𝑅1 + 𝑅2 + 𝑍𝐿
1

𝑅1 + 𝑅2 + 𝑍𝐿
+ 1

𝑅3 + 𝑍𝐶

= 231.9/−47.2∘ V

άρα
̇𝐼2 = −

̇𝑉𝐴
𝑅3 + 𝑍𝐶

= 1.21/166.4∘ A ̇𝐼1 = −( ̇𝐼 + ̇𝐼2) = 0.72/85.3∘ A

Το σχηματικό LTspice που περιγράφει το κύκλωμα φαίνεται στο Σχ. 24.

Σχήμα 24: Σχηματικό ac κυκλώματος.

Σχήμα 25: Εισαγωγή τιμής της πηγής τάσης.

Για την εισαγωγή τιμής της πηγής τάσης ακολουθούμε τη διαδικασία που φαίνεται στο Σχ. 25. Η αριστερή εικόνα
εμφανίζεται όταν κάνουμε κλικ για να εισάγουμε τιμή στην πηγή τάσης. Εφόσον πρόκειται για εναλλασσόμενο
κάνουμε κλικ στο Advanced και εμφανίζεται η δεξιά εικόνα. Εισάγουμε μέτρο και γωνία όπως φαίνεται εκεί. Το
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AC 150 25 συνήθως χρειάζεται μετακίνηση και το μετακινούμε όπως τα στοιχεία. Με παρόμοιο τρόπο δίνουμε
τιμή και στην πηγή ρεύματος.

Για την τιμή της χωρητικότητας εισάγουμε 5u και το LTspice καταλαβαίνει ότι πρόκειται για 5 µF.

Όταν τρέχουμε το πρόγραμμα εμφανίζεται η καρτέλα του Σχ. 26.

Σχήμα 26: Πρώτη καρτέλα για τρέξιμο.

Επιλέγουμε AC Analysis και τιμές όπως στην καρτέλα του Σχ. 27. Θέλουμε μια λύση για τη συχνότητα 300 Hz.

Σχήμα 27: AC Analysis και τιμές.

Τα αποτελέσματα της ανάλυσης φαίνονται στο Σχ. 28.

Βλέπουμε ίδιες τιμές για το ̇𝐼1 και το I(R1). Για το ̇𝐼2 όμως βλέπουμε στο I(R3) ίδιο μέτρο αλλά διαφορά
180∘ (−13.6 + 180 = 166.4∘), δηλ φορά ρεύματος αντίθετη. Κοιτάζοντας το netlist, View -> SPICE Netlist που
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Σχήμα 28: Αποτελέσματα ανάλυσης.

φαίνεται στο Σχ. 29 βλέπουμε ότι το LTspice έχει το θετικό και αρνητικό άκρο της αντίστασης ανάποδα από
ότι το έχουμε πάρει εμείς. Άρα όλα καλά και οι τιμές συμφωνούν.

Σχήμα 29: Netlist σχηματικού.

Τα παραπάνω σας επιτρέπουν να αναλύσετε dc και ac κυκλώματα στη σταθερή κατάσταση. Στις σημειώσεις
εργαστηρίου θα δείτε και άλλες εφαρμογές.

2 Octave - μια μικρή εισαγωγή

2.1 Εισαγωγικά

Tη δεκαετία του 80 κυκλοφόρησε ελεύθερα (public domain) στο Διαδίκτυο ένα πακέτο από FORTRAN υπορου-
τίνες για εύκολες και γρήγορες πράξεις με πίνακες σε υπολογιστή. Διάφορες εταιρίες βελτίωσαν και αύξησαν τις
δυνατότητες του αρχικού πακέτου με την προσθήκη γραφικών και βιβλιοθηκών εξειδικευμένων συναρτήσεων
χρήσιμων σε πολλούς τομείς εφηρμοσμένων επιστημών. Η πιο επιτυχημένη εταιρία ήταν και είναι η Mathworks
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και το προϊόν της το MATLAB χρησιμοποιείται σήμερα διεθνώς σε πολλά πανεπιστήμια, ερευνητικά κέντρα
και εταιρίες που ασχολούνται με την έρευνα και την τεχνολογία.

Την ίδια δεκαετία ξεκίνησε και το ρεύμα του Ανοικτού Λογισμικού (Open Source) που με τη βοήθεια του
Διαδικτύου έδωσε την ευκαιρία σε πολλούς νέους ερευνητές να συνεργαστούν εθελοντικά και να δημιουργήσουν
πολλές χρήσιμες εφαρμογές (π.χ. GCC C και C++ compilers και εργαλεία, λειτουργικό Linux, κλπ.).

Το MATLAB είναι αναμφισβήτητα ένα από τα πιο χρήσιμα εργαλεία που μαθαίνει ένας μηχανικός/επιστήμονας
και σε όλα σχεδόν τα πανεπιστήμια των τεχνολογικά προηγμένων χωρών του εξωτερικού επιβάλλεται η διδα-
σκαλία του από την αρχή των σπουδών του. Εκτός όμως από το εμπορικό πακέτο MATLAB που η πλήρης
έκδοση έχει αρκετά υψηλό κόστος, ερευνητές που χρησιμοποιούν εργαλεία ανοικτού λογισμικού δημιούργησαν
άλλα πακέτα/εφαρμογές με παρόμοιες δυνατότητες, που έχουν το πλεονέκτημα να είναι νομίμως δωρεάν. Ένα
από αυτά, το Octave, από τα Πανεπιστήμια Wisconsin-Madison και Texas της Αμερικής, έχει σχεδιαστεί με
στόχο την όσο το δυνατόν πλήρη συμβατότητα με το MATLAB. Διαθέτει πολλές από τις βασικές δυνατότητες
του MATLAB και βρίσκεται σε συνεχή ανάπτυξη για περαιτέρω βελτίωση. Τα προγράμματα που θα ετοιμάζουμε
παρακάτω μπορούν να τρέξουν σχεδόν αυτούσια και στα δυο περιβάλλοντα.

Ένα συνηθισμένο σενάριο σε πανεπιστήμια του εξωτερικού είναι το πανεπιστήμιο να διαθέτει άδεια χρήσης
του MATLAB στο χώρο του πανεπιστημίου και οι σπουδαστές να χρησιμοποιούν το Octave στο σπίτι τους για
τις εργασίες τους.

Επισημαίνεται ότι η Mathworks προσφέρει και στην Ελλάδα φοιτητική έκδοση MATLAB με κόστος γύρω στα
100€.

Η τελευταία έκδοση Octave (Ιούλιος 2021) είναι η 6.3.0. Ξεκινούμε με οδηγίες εγκατάστασης σε περιβάλλον
Windows.

2.2 Εγκατάσταση

Το επίσημο site του Octave είναι εδώ: Octave. Πάτε στο Download και μπορείτε να κατεβάσετε το αντίστοιχο
installer για το λειτουργικό σας. Το Octave προσφέρει τη δυνατότητα εργασίας σε δυο περιβάλλοντα, το γραφικό
περιβάλλον, GUI (Graphical User Interface) και το περιβάλλον κονσόλας, CLI (Command Line Interface) και η
τελευταία έκδοση έχει απλοποιήσει αρκετά πράγματα.

Η εγκατάσταση είναι απλή. Απλώς τρέχετε το installer και ακολουθείτε τα προεπιλεγμένα βήματα που εμφα-
νίζονται. Το παράθυρο που ανοίγει μετά την εγκατάσταση στο GUI φαίνεται στο Σχ. 30.

Προαιρετικά, κατεβάζετε επίσης τα ακόλουθα λογισμικά από το διαδίκτυο:

Notepad++ Editor Notepad++, από το notepad-plus-plus, ένας βελτιωμένος editor, που αντικαθιστά τους
Notepad και Wordpad editors των Windows. Το Notepad++ εξειδικεύεται για προγραμματιστές που γρά-
φουν κώδικα σε πληθώρα γλωσσών και θα σας φανεί χρήσιμο και αλλού. Αν και η έκδοση Octave
συμπεριλαμβάνει δικό της editor στο περιβάλλον GUI, στο περιβάλλον CLI θα χρειαστείτε τον Notepad++
για να φτιάξετε τα δικά σας προγράμματα.

Inkscape Πρόγραμμα δημιουργίας και επεξεργασίας γραφικών από inkscape.org. Πηγαίνετε στο DOWNLOAD
-> Windows installer και κατεβάστε την 64bit ή 32bit έκδοση που αντιστοιχεί στο δικό σας σύστημα.
Χρήσιμο, αν χρησιμοποιείτε γραφικές παραστάσεις σε svg.

7zip Τέλος, αν δεν έχετε εφαρμογή συμπίεσης αρχείων winzip ή winrar συνιστώ την 7zip από το 7-zip.org.
Τέτοια εφαρμογή είναι απαραίτητη όταν ανεβάζετε εργασίες σε ενιαίο αρχείο στο eclass.

Κάθε φορά που αρχίζουμε μια συνεδρία με το Octave το πρόγραμμα «βλέπει» έναν συγκεκριμένο φάκελο (folder)
όπου μπορεί να διαβάσει και να αποθηκεύσει αρχεία δεδομένων ή γραφικών παραστάσεων. Ο φάκελος αυτός
ονομάζεται φάκελος εργασίας. Η αρχική θέση του φακέλου εργασίας εξαρτάται από την έκδοση του Octave και
το λειτουργικό σύστημα. Π.χ. σε περιβάλλον Windows βλέπουμε ότι είμαστε στο C:/Users/Tasos αν Tasos είναι
το όνομα χρήστη (περιοχή File Browser επάνω αριστερά). Αν χρησιμοποιούμε Octave CLI πληκτρολογούμε pwd
(print working directory) και το αποτέλεσμα εμφανίζεται στην κονσόλα. Χρήσιμο είναι να δημιουργήσετε έναν
ξεχωριστό φάκελο, π.χ. C:\work και να έχετε το octave να πηγαίνει κατευθείαν εκεί.

Δημιουργείστε πρώτα αυτόν τον φάκελο, π.χ. C:\work εξωτερικά του Octave με τον τρόπο που συνήθως
χρησιμοποιείτε να δημιουργήσετε φακέλλους και μετά, μέσα στο Octave, στο Edit -> Preferences -> General
δηλώστε τον σαν αρχικό φάκελο εργασίας στον οποίο θα ανοίγει πάντα το πρόγραμμά σας (Σχ. 31). Στο Edit
-> Preferences -> Editor σετάρετε επίσης text encoding UTF-8 (Σχ. 32) που θα σας επιτρέψει αργότερα να
έχετε και ελληνικούς χαρακτήρες στις γραφικές και σχόλιά σας.

Στόχος σε εμάς τους Έλληνες χρήστες είναι να μπορούμε να εισάγουμε γραφικές με ελληνικούς χαρακτήρες
σε εφαρμογές επεξεργασίας κειμένου (π.χ. Word, LibreOffice) για οτιδήποτε εργασίες ή αναφορές θέλουμε.
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Σχήμα 30: Octave GUI περιβάλλον για έκδοση 6.3.0. Διακρίνουμε το Command Window (κονσόλα εντολών) τον
Editor και την τεκμηρίωση (Documentation) με οδηγίες και online βοήθεια. Διακρίνουμε επίσης τον τρέχοντα
φάκελο εργασίας.

Σχήμα 31: Edit -> Preferences -> General, σετάρισμα αρχικού φακέλου εργασίας.
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Σχήμα 32: Edit -> Preferences -> Editor, σετάρισμα UTF-8 text encoding.

Ελληνικούς χαρακτήρες ΔΕΝ βλέπουμε στην κονσόλα. Βλέπουμε όμως στον editor αν τον ρυθμίσουμε όπως
παραπάνω.

Με την τελευταία έκδοση βλέπουμε υποστήριξη Ελληνικών σε γραφικές σε αρχεία τύπου png και δεν χρειάζεται
κάτι επιπλέον. Αν θέλουμε όμως vector graphics τότε θέλουμε αρχεία svg και χρειαζόμαστε επιπλέον και την
εφαρμογή Inkscape που αναφέρθηκε παραπάνω.

2.3 Octave σαν «κομπιουτεράκι»

Η πρώτη και πιο απλή χρήση του Octave είναι να το χρησιμοποιήσει κανείς σαν «κομπιουτεράκι». Όλες οι
γνωστές αλγεβρικές πράξεις υποστηρίζονται.

+ πρόσθεση
− αφαίρεση
* πολλαπλασιασμός
/ διαίρεση
^ ύψωση σε δύναμη

Το πρόγραμμα εκτελεί αμέσως κάθε εντολή/πράξη και δίνει το αποτέλεσμα στη μεταβλητή ans.

>> 5+3
ans = 8
>> 89*5
ans = 445
>> 56-8+9-45.5
ans = 11.500
>> 5/3
ans = 1.6667

Για αριθμούς που είναι δυνάμεις του 10, χρησιμοποιείται η εκθετική μορφή με το σύμβολο e (exponent - εκθέτης),
π.χ. 3.245 × 103 = 3.245e3, −6.736 × 10−6 = -6.736e-6.

Υπάρχει πληθώρα ενσωματωμένων συναρτήσεων, πολύ περισσοτέρων από ένα «κομπιουτεράκι». Στον πίνακα
(Πιν. 2) φαίνονται μερικές από αυτές.

Η πλήρης συλλογή συναρτήσεων του Octave φαίνεται αν πάτε στο Documentation και ανοίξετε το Function
Index. Αν θέλουμε βοήθεια για κάποια συγκεκριμένη εντολή, π.χ. την εντολή load μπορούμε επίσης να πληκτρο-
λογήσουμε απλώς help load στην κονσόλα. Ανοίγει τότε ο ενσωματωμένος info-reader κονσόλας με σύντομες
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Πίνακας 2: Πίνακας συνήθων ενσωματωμένων συναρτήσεων

abs(x) απόλυτος τιμή ή μέτρο μιγαδικού αριθμού x
sin(x) ημίτονο του x όπου x σε rad
cos(x) συνημίτονο του x όπου x σε rad
tan(x) εφαπτομένη του x όπου x σε rad
asin(x) τόξο ημιτόνου x σε rad
acos(x) τόξο συνημιτόνου x σε rad
atan(x) τόξο εφαπτομένης x σε rad
atan2(y,x) τόξο εφαπτομένης tan−1(𝑦/𝑥) σε rad
exp(x) εκθετικό του x, 𝑒𝑥

sqrt(x) τετραγωνική ρίζα του x
real(x) πραγματικό μέρος του μιγαδικού αριθμού x
imag(x) φανταστικό μέρος του μιγαδικού αριθμού x
conj(x) συζυγής μιγαδικός του x
log(x) φυσικός λογάριθμος (βάση e) του αριθμού x
log10(x) δεκαδικός λογάριθμος (βάση 10) του αριθμού x
log2(x) δεκαδικός λογάριθμος (βάση 2) του αριθμού x

πληροφορίες βοήθειας. Αν η βοήθεια συμπεριλαμβάνει πολλές σελίδες πηγαίνουμε στην επόμενη πληκτρολο-
γώντας το spacebar. Βγαίνουμε από τον info-reader πληκτρολογώντας q.

Υπενθυμίζεται ότι ισχύει η προτεραιότητα των πράξεων όπως φαίνεται στον πίνακα Πιν. 3. Αν κάπου έχετε

Πίνακας 3: Προτεραιότητα των πράξεων

() Πρώτα υπολογίζονται οι πράξεις μέσα σε παρενθέσεις
^ Ακολουθεί η ύψωση σε δύναμη
*/ Πολλαπλασιασμός και διαίρεση έχουν ίδια προτεραιότητα και εκτελούνται από αριστερά προς τα δεξιά
+- Πρόσθεση και αφαίρεση έχουν ίδια προτεραιότητα και εκτελούνται από αριστερά προς τα δεξιά

αμφιβολία χρησιμοποιείστε επιπλέον παρενθέσεις.

Ακολουθούν παραδείγματα με μιγαδικούς αριθμούς και τριγωνομετρικές συναρτήσεις που θα μας χρειαστούν
στο εναλλασσόμενο. Προσέξτε στις τελευταίες ότι οι γωνίες είναι σε ακτίνια (rad). Η μετατροπή από rad σε
μοίρες γίνεται πολλαπλασιάζοντας με 180/𝜋 και από μοίρες σε rad πολλαπλασιάζοντας με 𝜋/180.

>> sin(60*pi/180)
ans = 0.86603
>> asin(ans)*180/pi
ans = 60.000
>> z=5+j*3
z = 5 + 3i
>> abs(z)
ans = 5.8310
>> real(z)
ans = 5
>> imag(z)
ans = 3
>> atan2(imag(z),real(z))*180/pi
ans = 30.964
>> [abs(z) angle(z)*180/pi]
ans =

5.8310 30.9638

Η τελευταία εντολή μας μετατρέπει τον μιγαδικό αριθμό από καρτεσιανή σε πολική μορφή με τη συνάρτηση
angle. Με τις αγκύλες [ ] απλώς παρουσιάζουμε το αποτέλεσμα μέτρο, γωνία (σε μοίρες) το ένα μετά το άλλο
στην ίδια γραμμή.

Το αντίστροφο, όπου μετατρέπουμε έναν μιγαδικό από πολική μορφή (φάσορα) σε καρτεσιανή, π.χ. τον 5 /45∘,
το επιτυγχάνουμε ως εξής:

>> 5*exp(j*45*pi/180)
ans = 3.5355 + 3.5355i

Υπενθυμίζεται ότι ένας μιγαδικός αριθμός ορίζεται σαν 𝑧 = 𝑎 + 𝑗𝑏 = 𝑟 /𝜃 = 𝑟 𝑒𝑗𝜃 όπου 𝑟 =
√

𝑎2 + 𝑏2 και 𝜃 το
όρισμα σε rad. Επομένως 5 /45∘ = 5 𝑒𝑗45𝜋/180.
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Μια μεταβλητή στο Octave όπως και σε άλλες γλώσσες προγραμματισμού χρησιμοποιείται σαν ενα σύμβολο
για μια θέση μνήμης που περιέχει κάποια τιμή. Μπορούμε να δώσουμε δικά μας ονόματα σε μεταβλητές ή,
αν δεν το κάνουμε αυτό, το Octave χρησιμοποιεί μια δική του μεταβλητή, την ans (answer – απάντηση) σαν
στιγμιαία θέση μνήμης για το πιο πρόσφατο αποτέλεσμα (την μεταβλητή αυτή μπορούμε αν θέλουμε να την
χρησιμοποιήσουμε και εμείς στην αμέσως επόμενη εντολή).

Υπενθυμίζεται επίσης ότι το = στον προγραμματισμό έχει διαφορετική σημασία από ότι στα μαθηματικά. Η
έκφραση x=2 σημαίνει ότι η θέση μνήμης που έχει όνομα το σύμβολο μεταβλητής x θα πάρει την τιμή 2. H
έκφραση x=x+2 σημαίνει ότι στη θέση μνήμης που συμβολίζεται με το x θα προστεθεί η τιμή 2 και το αποτέλεσμα
θα τοποθετηθεί πάλι στη θέση μνήμης x. Δηλ. για ότι αλγεβρική έκφραση είναι στα δεξιά του =, θα γίνουν οι
πράξεις, και το αποτέλεσμα θα αποθηκευτεί στη θέση μνήμης που υπάρχει στα αριστερά του =. Που σημαίνει
ότι οι εκφράσεις στα δεξιά πρέπει να καταλήγουν σε κάποιο αριθμητικό αποτέλεσμα και δεν επιτρέπεται στα
αριστερά να έχουμε αριθμητικές πράξεις αλλά κάποια μεταβλητή που δηλώνει κάποια θέση μνήμης.

2.4 Μεταβλητές, διανύσματα και πίνακες

Όπως σε κάθε γλώσσα προγραμματισμού μπορούμε και εδώ να χρησιμοποιήσουμε μεταβλητές. Π.χ. νόμος του
Ohm. Αν είναι γνωστή η τάση 𝑉 στα άκρα κάποιας αντίστασης καθώς και το ρεύμα 𝐼 που την διαρρέει, τότε
η τιμή της αντίστασης είναι 𝑅 = 𝑉 /𝐼 . Στο octave:

>> V=220
V = 220
>> I=2
I = 2
>> R=V/I
R = 110

ή, πιο συνοπτικά:

V=220; I=2; R=V/I
R = 110

Το ; απενεργοποιεί ηχώ αποτελεσμάτων και δίνει τη δυνατότητα να τοποθετήσουμε πολλές εντολές σε μια
γραμμή. Μπορούμε επίσης με τον editor να φτιάξουμε πρόγραμμα με όνομα της επιλογής μας και κατάληξη m.
Για το παραπάνω παράδειγμα έστω πρόγραμμα tata.m με περιεχόμενο μια γραμμή σχόλιο (αρχίζει με %) και την
εκτελέσιμη γραμμή που χρησιμοποιήσαμε παραπάνω::

% σχόλιο για απλό παράδειγμα νόμου Ohm
V=220; I=2; R=V/I

Το αποθηκεύουμε μέσω editor στον φάκελο εργασίας και το τρέχουμε στην κονσόλα πληκτρολογώντας το
όνομά του χωρίς την κατάληξη m, ή πιο απλά, από το βελάκι στο toolbar του editor που λέει save and run αν
κάνουμε hover με το ποντίκι μας. Το octave θα το τρέξει και θα παρουσιάσει το αποτέλεσμα. Προφανώς, τα
προγράμματα είναι χρήσιμα όταν έχουμε πολλές γραμμές κώδικα.

Μπορούμε να χειριστούμε διανύσματα και πίνακες σαν να είναι απλές μεταβλητές. Ένα διάνυσμα είναι απλώς
μια ακολουθία αριθμών διατεταγμένων με κάποια συγκεκριμένη σειρά. Ακολουθεί παράδειγμα διανύσματος
γραμμής

>> x=[0,1,3,6]
x =

0 1 3 6
>> y = [6 3 1 0]
y =

6 3 1 0
>> z = x + y
z =

6 4 4 6
>> size(x)
ans =

1 4
>> size(y)
ans =

1 4
>> size(z)
ans =

1 4

και διανύσματος στήλης
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>> a=[1 3 -5]’
a =

1
3
-5

>> size(a)
ans =

3 1
>> b=[3; -6; 10]
b =

3
-6
10

>> size(b)
ans =

3 1
>> z1 = 5+3*j
z1 = 5 + 3i
>> z2=6-4*j
z2 = 6 - 4i
>> x=[z1 z2]
x =

5 + 3i 6 - 4i
>> x’
ans =

5 - 3i
6 + 4i

>> x.’
ans =

5 + 3i
6 - 4i

Χρησιμοποιούμε [ ] για να ορίσουμε τέτοιες ακολουθίες και χωρίζουμε τα στοιχεία τους με κόμμα ή κενό.
Προσέξτε τη χρήση της συνάρτησης size που μας δίνει τις γραμμές/στήλες των διανυσμάτων. Προσέξτε επίσης
τους τρόπους για την κατασκευή διανύσματος στήλης. Με ’ αντιμεταθέτουμε γραμμές στήλες με τον συζυγή
μιγαδικό. Με .’ αντιμεταθέτουμε καθαρά γραμμές και στήλες. Και με ; ξεχωρίζουμε εξ αρχής τις γραμμές.

Μπορούμε επίσης να κατασκευάσουμε διανύσματα από άλλα διανύσματα φτάνει να ταιριάζουν οι εκάστοτε
διαστάσεις.

>> a=[1 2 3];
>> b=[4 5];
>> c=[a -b]
c =

1 2 3 -4 -5
>> d=[-10; 3]
d =

-10
3

>> a
a =

1 2 3
>> e=[a d]
error: horizontal dimensions mismatch (1x3 vs 2x1)

Ένας εναλλακτικός τρόπος κατασκευής διανυσμάτων αύξουσας ακολουθίας είναι με το σύμβολο/τελεστή :
όπου δίνουμε αρχική και τελική τιμή (υπονοείται βήμα 1) ή, αρχική τιμή, βήμα και τελική τιμή. Προφανώς με
αρνητικό βήμα μπορούμε να φτιάξουμε φθίνουσα ακολουθία.

>> x=1:10
x =
Columns 1 through 9:

1 2 3 4 5 6 7 8 9
Column 10:

10
>> y=0:0.1:1
y =
Columns 1 through 9:
0.00000 0.10000 0.20000 0.30000 0.40000 0.50000 0.60000 0.70000 0.80000

Columns 10 and 11:
0.90000 1.00000

>> Ts=0.2
Ts = 0.20000
>> t=0:Ts:1
t =

0.00000 0.20000 0.40000 0.60000 0.80000 1.00000
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>> x=-1:0.1:1
x =
Columns 1 through 8:

-1.0000 -0.9000 -0.8000 -0.7000 -0.6000 -0.5000 -0.4000 -0.3000
Columns 9 through 16:

-0.2000 -0.1000 0.0000 0.1000 0.2000 0.3000 0.4000 0.5000
Columns 17 through 21:

0.6000 0.7000 0.8000 0.9000 1.0000
>> x=-1:0.15:1
x =
Columns 1 through 8:

-1.0000 -0.8500 -0.7000 -0.5500 -0.4000 -0.2500 -0.1000 0.0500
Columns 9 through 14:

0.2000 0.3500 0.5000 0.6500 0.8000 0.9500

Το τελευταίο στοιχείο της ακολουθίας συμπεριλαμβάνεται εάν είναι πολλαπλάσιο του βήματος. Αλλιώς, όχι.

Ένας πίνακας δυο διαστάσεων μπορεί να οριστεί ως εξής:

>> A=[3 5 1 -4; 4 91 2 4; 0 4 -8 2]
A =

3 5 1 -4
4 91 2 4
0 4 -8 2

όπου ορίσαμε έναν πίνακα 3 × 4, και όπως βλέπουμε χωρίζουμε τις γραμμές με το σύμβολο ;.

Μπορούμε επίσης να αντιμεταθέσουμε γραμμές και στήλες με το σύμβολο ’

>> A’
ans =

3 4 0
5 91 4
1 2 -8
-4 4 2

Τα παραπάνω ισχύουν και για πίνακες με μιγαδικούς αριθμούς, μόνο που τότε το σύμβολο ’ δείχνει ότι στην
πραγματικότητα γίνεται ερμητιανή αντιμετάθεση (Hermitian Transpose) δηλ. στην αντιμετάθεση αντικαθιστού-
νται οι αριθμοί με τον μιγαδικό συζυγή τους. Αν θέλουμε απλή αντιμετάθεση χρησιμοποιούμε την συνάρτηση
conj που υπολογίζει τον μιγαδικό συζυγή, ή το σύνθετο σύμβολο .’.

>> x=[3 4+j*5 -2-j*9]
x =

3 + 0i 4 + 5i -2 - 9i
>> x’
ans =

3 - 0i
4 - 5i
-2 + 9i

>> conj(x)’
ans =

3 + 0i
4 + 5i
-2 - 9i

>> x.’
ans =

3 + 0i
4 + 5i
-2 - 9i

Έστω τώρα ότι θέλουμε να λύσουμε το γραμμικό σύστημα

3𝑥1 − 4𝑥2 + 5𝑥3 = 0
𝑥1 + 9𝑥2 + 2𝑥3 = 3

−4𝑥1 + 9𝑥2 + 𝑥3 = 1

Ορίζουμε τον πίνακα των συντελεστών A, το γνωστό διάνυσμα στήλης b και η λύση θα είναι το διάνυσμα στήλης
x.

>> A=[3 -4 5; 1 9 2; -4 9 1]
A =

3 -4 5
1 9 2
-4 9 1
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>> b=[0; 3; 1]
b =

0
3
1

>> x=inv(A)*b
x =

0.4017094
0.2905983
-0.0085470

όπου βλέπουμε ότι μπορούμε να χρησιμοποιήσουμε τη σχέση x=inv(A)*b για να βρούμε το x. Μπορούμε επίσης
να κάνουμε μια επαλήθευση του αποτελέσματος αφαιρώντας το σύστημα 𝐴𝑥 από το γνωστό διάνυσμα 𝑏

>> A*x-b
ans =

-2.7756e-16
4.4409e-16
4.4409e-16

και βλέπουμε ότι η απάντηση είναι της τάξης 10−16, πρακτικά μηδέν, όπως πρέπει να είναι. Είναι πιθανόν, στο
δικό σας σύστημα, να δείτε λίγο διαφορετικά, αλλά και πάλι πολύ μικρά νούμερα.

Με τα διανύσματα και τους πίνακες βρίσκουμε πολύ χρήσιμες τις συναρτήσεις length και size. Η πρώτη μας
δίνει το μήκος ενός διανύσματος (δηλ. τον αριθμό των στοιχείων του) και η δεύτερη το μέγεθος ενός διανύσματος
ή πίνακα (δηλ. τον αριθμό των γραμμών και στηλών).

>> y=0:0.2:2
y =
Columns 1 through 9:
0.00000 0.20000 0.40000 0.60000 0.80000 1.00000 1.20000 1.40000 1.60000

Columns 10 and 11:
1.80000 2.00000

>> length(y)
ans = 11
>> size(y)
ans =

1 11
>> A=[3 -9 0 12; 9 -2 -4 0; -1 9 5 2]
A =

3 -9 0 12
9 -2 -4 0
-1 9 5 2

>> size(A)
ans =

3 4

Οι δείκτες στα διανύσματα και στους πίνακες ξεκινούν από την τιμή 1 μέχρι το μέγεθος της εκάστοτε γραμμής
ή στήλης. Αν θέλουμε κάποιο συγκεκριμένο στοιχείο το αναφέρουμε με τον ή τους δείκτες του.

>> x=0:0.1:1
x =
Columns 1 through 9:
0.00000 0.10000 0.20000 0.30000 0.40000 0.50000 0.60000 0.70000 0.80000

Columns 10 and 11:
0.90000 1.00000

>> x(3)
ans = 0.20000
>> x(8)
ans = 0.70000
>> A
A =

3 -9 0 12
9 -2 -4 0
-1 9 5 2

>> A(2,3)
ans = -4
>> A(4,2)
error: A(I,J): row index out of bounds; value 4 out of bound 3
>> A(3,1)
ans = -1

Μπορούμε επίσης να χρησιμοποιήσουμε κατάλληλα τους δείκτες και να παράγουμε άλλα διανύσματα ή πίνακες.
Π.χ.
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>> u=1:10
u =
Columns 1 through 9:

1 2 3 4 5 6 7 8 9
Column 10:

10
>> u(1:2:10)
ans =

1 3 5 7 9
>> u(3:2:8)
ans =

3 5 7
>> A
A =

3 -9 0 12
9 -2 -4 0
-1 9 5 2

>> A(1:3,1:3)
ans =

3 -9 0
9 -2 -4
-1 9 5

>> A(2,1:3)
ans =

9 -2 -4
>> A(3,:)
ans =

-1 9 5 2
>> A(:)
ans =

3
9
-1
-9
-2
9
0
-4
5
12
0
2

Βλέπουμε ότι μπορούμε να πάρουμε συγκεκριμένα υποσύνολα από διανύσματα ή πίνακες φτάνει να μπορούμε
να τα περιγράψουμε κατάλληλα με τους δείκτες τους.

Τα παραπάνω είναι αρκετά για να αρχίσουμε να χρησιμοποιούμε το octave στις ασκήσεις μας στα ηλεκτρικά
κυκλώματα.

2.5 Κυκλώματα DC

2.5.1 Κύκλωμα ενός βρόχου

Έστω το κύκλωμα ενός βρόχου στο Σχ. 33.

−
+𝐸1

𝑅1

𝑅2

−+

𝐸2

𝑅3

−
+ 𝐸3

𝑅4

𝐼

Σχήμα 33: Κύκλωμα ενός βρόχου
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Αν είναι γνωστές οι τιμές των στοιχείων μπορούμε να εφαρμόσουμε κανόνα τάσεων Kirchhoff και να βρούμε το
ρεύμα βρόχου 𝐼 .

−𝐸1 + 𝐼𝑅1 + 𝐼𝑅2 + 𝐸2 + 𝐼𝑅3 − 𝐸3 + 𝐼𝑅4 = 0 ⇒ 𝐼 = 𝐸1 − 𝐸2 + 𝐸3
𝑅1 + 𝑅2 + 𝑅3 + 𝑅4

Με octave:

>> E1=10; E2=6; E3=4.2; R1=1e3; R2=900; R3=2.1e3; R4=760;
>> I = (E1-E2+E3) / (R1+R2+R3+R4)
I = 1.7227e-03
printf(”I = %g mA\n”,I*1e3)
I = 1.7227 mA

Εδώ βλέπουμε και τη χρήση της εντολής printf, που εκτυπώνει string με ότι περιεχόμενο θέλουμε μεταξύ των
” ή ’. Το %g είναι placeholder που καταχωρεί την τιμή της μεταβλητής που ακολουθεί. Μπορούμε να έχουμε
όσα placeholders θέλουμε για όσες μεταβλητές ακολουθούν. Το g είναι generic specifier και χειρίζεται με γενικό
τρόπο ακέραιους και πραγματικούς. Υπάρχουν και άλλα specifiers και μπορούμε να επέμβουμε στον αριθμό
των δεκαδικών που εμφανίζονται. Περισσότερες λεπτομέρειες εδώ. Το \n είναι το newline που απλώς σημαίνει
ότι πάει στην επόμενη γραμμή.

2.5.2 Κύκλωμα δυο βρόχων

Έστω το κύκλωμα δυο βρόχων στο Σχ. 34. Με γνωστές τις τιμές των στοιχείων μπορούμε να αναλύσουμε το

−
+𝐸1

𝑅1 𝐼1

𝑅2

𝐼2

𝑅3𝐼3

−
+ 𝐸2

𝐴

𝐵

Σχήμα 34: Κύκλωμα δυο βρόχων

κύκλωμα με δυο τρόπους.

Κλαδικά ρεύματα: Εφαρμογή κανόνα ρευμάτων στον κόμβο 𝐴 και κανόνα τάσεων στους δυο οφθαλμούς:

𝐼1 − 𝐼2 − 𝐼3 = 0
𝑅1𝐼1 + 𝑅2𝐼2 = 𝐸1
𝑅3𝐼3 − 𝑅2𝐼2 = −𝐸2

⎫}
⎬}⎭

⇒
𝐼1 − 𝐼2 − 𝐼3 = 0

𝐼1 = (𝐸1 − 𝑅2𝐼2)/𝑅1
𝐼3 = (−𝐸2 + 𝑅2𝐼2)/𝑅3

⎫}
⎬}⎭

⇒ 𝐼2 =
𝐸1
𝑅1

+ 𝐸2
𝑅3

1 + 𝑅2
𝑅1

+ 𝑅2
𝑅3

Υπολογίζουμε το 𝐼2 και από εκεί τα 𝐼1, 𝐼3.

Με octave λύνουμε απλώς το αρχικό σύστημα:

>> E1=10; E2=6; R1=1e3; R2=900; R3=2.1e3;
>> A = [1 -1 -1; R1 R2 0; 0 -R2 R3]
A =

1 -1 -1
1000 900 0

0 -900 2100
>> b=[0; E1; -E2]
b =

0
10
-6

>> I = inv(A)*b
I =

5.0307e-03
5.5215e-03
-4.9080e-04

>> printf(”I1 = %g mA, I2 = %g mA, I3 = %g mA\n”,I(1)*1e3,I(2)*1e3,I(3)*1e3)
I1 = 5.03067 mA, I2 = 5.52147 mA, I3 = -0.490798 mA
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Κομβική ανάλυση: Κανόνα ρευμάτων στον κόμβο 𝐴 όπου εκφράζουμε τα κλαδικά ρεύματα μέσω των κομβικών
τάσεων θεωρώντας τον κόμβο 𝐵 γη.

𝑉𝐴 − 𝐸1
𝑅1

+ 𝑉𝐴
𝑅2

+ 𝑉𝐴 − 𝐸2
𝑅3

= 0 ⇒ 𝑉𝐴 =
𝐸1
𝑅1

+ 𝐸2
𝑅3

1
𝑅1

+ 1
𝑅2

+ 1
𝑅3

⇒ 𝐼1 = 𝐸1 − 𝑉𝐴
𝑅1

, 𝐼2 = 𝑉𝐴
𝑅2

, 𝐼3 = 𝑉𝐴 − 𝐸2
𝑅3

Με octave έχουμε:

>> E1=10; E2=6; R1=1e3; R2=900; R3=2.1e3;
>> Va = (E1/R1+E2/R3)/(1/R1+1/R2+1/R3)
Va = 4.9693
>> I1=(E1-Va)/R1
I1 = 5.0307e-03
>> I2=Va/R2
I2 = 5.5215e-03
>> I3=(Va-E2)/R3
I3 = -4.9080e-04
>> printf(”I1 = %g mA, I2 = %g mA, I3 = %g mA\n”,I1*1e3,I2*1e3,I3*1e3)
I1 = 5.03067 mA, I2 = 5.52147 mA, I3 = -0.490798 mA

Ίδια απάντηση όπως και πριν. Η κομβική ανάλυση αποφεύγει το 3ης τάξης σύστημα αλλά θέλει λίγη άλγεβρα
και ιδιαίτερη προσοχή στα πρόσημα για να βγει σωστά η λύση.
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